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IBM® WebSphere® Process Server V6.1 — Lab exercise

Business state machine: Account manager
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What this exercise is about

The objective of this lab is to provide you with an understanding of the Business State Machine and how to
develop an application using the state machine as the primary controller which drives other business
processes.

Lab requirements

List of system and software required for the student to complete the lab.

WebSphere Integration Developer V6 installed

WebSphere Process Server V6 test environment installed

Sample code in the directory c:\LabFiles602 (Windows®) or /tmp/LabFiles602 (Linux®)
You should already be familiar with the Component Test Client.

You should know how to wire up a module assembly, with Imports and Exports.

What you should be able to do

At the end of this lab you should be able to:

Create and test a Business State Machine which collaborates with a BPEL business process using
Actions on the transition

Add Conditions to the Business State Machine to apply business restrictions to the overall business
process flow

Use the WebSphere Test Environment to move through the states of the Business State Machine.

Programmatically send events/operations to the Business State Machine from a long running BPEL
business process
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Introduction

This application is for the life cycle management of a customer account.

The sales team for ‘MyCompany’ will identify a new prospect and review the account to see what business
opportunities are available. If, as a result of the review, the sales team concludes that this is a good candidate,
then the sales team will work with the customer to complete the application. Once the application for a new
account is completed, it is verified for correctness and accuracy. Having been successfully verified, the
account can then be activated.

At any point in the business process the flow may be escalated to achieve greater focus and urgency or sent
back to the previous step for rework.

The underlying business processes such as review, apply, verify and escalate are implemented as long
running business processes that normally involve some kind of human interaction. (You will not implement
the human interactions at this time, since it is no t the main focus of the scenario .)

Additionally there will be Conditions/Guards on some of the transitions to insure that Tﬁhe criteria for moving
from one step to the next have been met. You will implement the conditions using Java snippets but you can
see how this would be a natural place to insert business rules.

The secondary, underlying business processes such as review, verify, and others, will send the events to the
business state machine either upon completion or escalation of the process. In the diagram below, when the
state machine is started with the newCustomer operation, the action labeled, Start the Review, invokes the
Review business process and the state machine will remain in the Review state until either the escalate or the
apply operations are invoked.

This diagram is not complete yet. To make this state machine behave properly, you must add additional
Actions to invoke the other business processes and then some conditions. Notice that the Escalate state has
many possible resubmit transitions. If you leave it like this the Business State Machine runtime will not be able
to determine which transition to use and the editor will flag this as an error. This ambiguity is resolved by using
conditions based on the input of the escalate operation.
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Managing a customer account can be a complex business process. The customer account has a life cycle that
must me carefully managed. There are typically several phases, each of which can be defined as a BPEL
business process. In this exercise you will see how the business state machine can be used to apply the

overall top-level control structure to the various phases of the account management life cycle.

The BPEL business processes, which will be long running, will be invoked using the actions on the transitions
of the business state machine (BSM). Additionally, conditions will be added to the transitions to apply business
rules, either Conditions or real Business Rules.

A few words on the structure of the application:

There are two SCA Modules and one Library Module.

1. AccountManagerBSM

2. AccountManagementProcesses

3. AccountManLib

The Library Module contains the interfaces and the schema definitions used by the other two modules.
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Exercise instructions

Some instructions in this lab might be specific for Windows platforms. If you run the lab on a platform other
than Windows, you will need to run the appropriate commands, and use appropriate files ( for example .sh in
place of .bat) for your operating system. The directory locations are specified in the lab instructions using
symbolic references as follows:

<WPS_HOME> C\IBM\WID61\runtimes\bi_v61
<WPS_PROFILE_HOME> C\IBM\WID61\pfiwps
<LAB_FILES> C:\LabFiles61

Windows users : When directory locations are passed as parameters to a Java program such as EJBdeploy or
wsadmin, you must replace the backslashes with forward slashes to follow the Java convention. For example,
replace C:\LabFiles61\ with C:/LabFiles61

Instructions for using a remote testing environment, such as z/0S®, AIX or Solaris, can be found at the end of
this document, in the section “Task: Adding remote server to WebSphere Integration Developer test
environment ”.
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Part 1: Getting started
1. Follow the directions below to initialize the Workspace using the following values:
<WORKSPACE>

C:\LabFiles61\BusinessStateMachines\workspace
<PROJECT_INTERCHANGE>
C:\LabFiles61\BusinessStateMachines\Snippets\AccountManager.beta.pi.zip
2. Startthe WebSphere Integration Developer and setup the environment

___a. When prompted for workspace name, enter the value provided by the <WORKSPACE> variable
for this lab and click OK

#= Workspace Launcher

Select a workspace

IEM WebSphere Integration Developer 6,1 stares wour projects in a folder called a workspace,
Choose a workspace Folder to use For this session.

ey ==t B abFilest 11 BusinessStakeMachinesiworkspace j Browse... |

[~ Use this as the default and do not ask again

Ik I Cancel |

___b. Close the Welcome tab

___c. Ensure you are in the Business Integration perspective.

3. If this lab requires you to import a project interchange file, setup the required libraries and modules
for this lab by importing the project interchange file <PROJECT_INTERCHANGE>
__a. From the file menu, select File > Import...
___b. In the Import dialog, scroll down, expand Other and select Project Interchange
2008 April, 08 IBM WebSphere Process Server V6.1 — Lab exercise
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= Import
Select

Y
Import a project and its dependent projects From a Zip file. E - 5

Select an impart source;

| bype filker bext

(== Team -
(= Test
= Web

-2 \Web services

(7) = Back I Bk = I Einish Cancel

___C. Click Next

___d. Inthe ‘Import Projects ’ panel, click the Browse button and select the project interchange file
located at <PROJECT_INTERCHANGE>

___e. Click the ‘Select All button

% Import Project Interchange Contents
Import Projects

Impark Projects Fram a zip file. I

= 4
Fram zip File: IC:'l,LaI:uFiIesﬁ1'I,BusinessStateMachines'l,Snippets'l,.ﬁ.ccu:uuntManager.beta.pi.zip j Browse, ., |
Project location rook: | CiLabfiless 1 BusinessStateMachinesiworkspace Browse. ., |

= AccountManLib
[=F AccountManagementProcesses
= AccountiManagerBsM

Deselect all | Select Referenced

(7) < Back, Mt = | Finish I Cancel

___f. Click Finish

4. Inspect the data objects in the ‘AccountManLib ' library

__a. Inthe project explorer, expand to ‘AccountManLib - Data Types’
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___b. Right click on ‘Account ' and select Open to inspect the Business Object. The variable
‘accountID ' is used as the correlation ID throughout the application

[ Account

[8] accountIDr skring

___c. Repeat step ‘b’ to inspect ‘Customer ’ business object

If_l Cuskomer

(8] name skring

(8] cuskomerID string

___d. Repeat step ‘b’ to inspect ‘Form’ business object

] Farm

[&] cuskamerInfa skring

[e] date dateTime

1) In the Form business object, ‘customerinfo ' is used to store any extra information about
the customer and ‘date’ is used to control execution logic added in ‘Part 3: Add
Condition

5. Inspect the Interfaces in the ‘AccountManLib ' library
___a. Inthe project explorer, expand to ‘AccountManLib - Interfaces’

___b. The ‘AccountManagerinterface ' defines the operations on the business state machine. To
cause a transition from one state to another, invoke one of these methods on an instance of the
business state machine. You will use the component test environment to do this for most of the
work you'll be doing

1) Note that all the operations will need to correlate. The variable ‘accountID ’ in the Account
business object is used throughout this exercise for this purpose
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___c. All of the interfaces with Process in the name are used for the BPEL business processes which
can be invoked by the Actions of the Account Management business state machine. Their
interfaces are all the same for this exercise

» ActivateProcessinterface
» ApplicationProcessinterface
* ReviewProcesssinterface
» VerificationProcesslInterface

6. Inspect the business process in the ‘AccountManagementProcess ' module.

__a. Inthe project explorer, expand to ‘AccountManagementProcess - Business Logic -
Processes’

___b. Double click on ‘ReviewProcess ’ to open it in the Business Process Editor

HiddenSequence
o | Receive
= Assign
4 Choice
Case Otherwise
<5> Escalate L;-g Snippet

= Initialize AckivationInfo
L;-g Signed OFf

<§> Ackivate

®

1) ReviewProcess is a simple and incomplete business process at this time. There will
eventually be one BPEL business process per state. It is not a requirement to implement
an Action as a business process; these instructions use a long running business process to
illustrate what can be done and to demonstrate how the different technologies can be used
together
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2) The ReviewProcess (BPEL) will check the name of the customer and if the name is on the
‘preferred customer’ list the business process will be escalated to ensure that it receives

the proper attention

7. Inspect the module assemblies for ‘AccountManagementProcess ' and ‘AccountManagerBSM '’
___a. Inthe project explorer, expand AccountManagementProcess

___b. Double-click on Assembly Diagram ("?@ Assembly Diagram) to open the Assembly Diagram

-

= O

*AccountManagementProcesses - Assembly Diagram X

-

@ 'E.:.{!’ ReviewProcessExport

—_—

Palette

—_—

(1) 2 ReviewProcess 1.1

(T & AccountManager

1) There is nothing special except the simplicity
2) AccountManagementProcess uses SCA bindings

___c. Inthe project explorer, expand ‘AccountManagerBSM ’
___d. Double-click on Assembly Diagram (-'?SI Assembly Diagram) to open the Assembly Diagram

o

=g

2

” @ 'Ei*".ﬁ.-:cuuntManagerBSMExpnrt
2

s

m

-

(I er AccountManagerBsM (L.t
(T = ReviewProcess
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Part 2: Make a test run

At this point there is enough of the state machine constructed so you can learn how to run it manually using
the Component Tester. This is what you will do in this section.

The Component Test Client will allow you to invoke any of the operations that have been exported from the
‘AccountManagerBSM ' module. You must have a separate invoke for each one. For this test run you will
setup three invokes initially. This will make it easier to step through the operations. As you move from state to
state and invoke BPEL business processes, there will be messages in the console to help you see the
transitions and actions.

The first operation you will invoke will be the ‘newCustomer ' operation, which will move the business state
machine from the initial state to the Review state, and invoke the ‘ReviewProcess ' as an action.

The ‘activate ' operation will cause the transition to the Active state if the WaitFor Condition has been met. The
WaitFor condition is a simple check against a timestamp to allow for a cooling off period before actually
activating the account. (Initially this is an automatic transition that will be called by the ReviewProcess
business process.) Of course this will be too soon for the condition so the state machine will remain in the
Review state until it times out or you invoke the activate operation again after the designated cool off period.

The next operation will be ‘terminate ’, which will cause the transition to the ‘nonActive ' state. The state
machine will remain in this state until the account has been ‘reActivated ’ or the ‘TermialTimeout ' has been
reached.

The next operation will again be ‘terminate ’, but this time the current state is notActive so the transition will be
to terminate the state machine, ‘End’.

Because of the way the timeouts are setup, if you do nothing after the initial invocation of newCustomer the
business state machine will terminate in about 5 to 10 minutes.

If you are interested in the ‘Escalate ' state, take a look at the ‘ReviewProcess ’
1. Start the test server

___a. Change to the Servers view

Note: If using a remote testing environment, follow the directions provided in Task: Adding remote server to
test environment at the end of this document to add a server to the test environment and start it. This is
especially true for z/OS, AIX®, Solaris remote test environment, where the WebSphere Integration Developer
will be remote to the test environment.

If using a local testing environment, right-click on WebSphere Process Server v6.1 and select
Start from the context menu

P ; N
Build Activities | Properties Prnblemsm i R aa [ S

SErver | Stakus | State |
. W' i@ Stopped Republish
g1 Lk ver wh, 1 ik Started Republish

= = )

2. Add both applications to the server when the server has started

___a. Right-click on the server and select ‘Add and Remove projects ' from the pop-up menu
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___b. Click the ‘Add All >> " button to add both applications to the server

#+* Add and Remove Projects | x|
Add and Remove Projects

Madify the projects that are configured on the server ‘ ‘

Maove projects to the right to configure them on the server

Available projects; Confiqured projects:

'E| AccountManagementProcessesapp
ndd > | "_E AccountManagerBSMADD
<= Rermoe |
add &l »> |
<< FRemove Al |

(7] = Back | Mext = | Einish I Zancel

___c. Click Finish

3. Start the Component Tester on the ‘AccountManagerBSM ' module

___a. Inthe project explorer, right click on ‘AccountManagerBSM ' module and select ‘Test - Test
Module ' from the pop-up menu

Note: If using a remote testing environment, select Project -> Properties - Integration Test Client .
Unselect the check box for ‘Always use the default target in the test client ' if selected and click OK. You'll
be prompted for your deploy location now when testing.

4. Run the tests

Note: Remember that the ‘accountID ’, act1234, is used to correlate the entire system. Enter act1234 for
accountiD.

___a. Add two invokes

1) In the ‘Events’ section, click the Invoke button two times; there should now be three
invokes listed as shown below:

Events b General Properties
& = | = = = Detailed Properties
p-=|F OE|E
gb Invoke Configuration: IDeFauIt Maodule Test j
B Trnvoke
Module: I.ﬁ.ccuuntManagerESM j

___b. Highlight the Invoke 1 and select ‘AccountManagerBSMExport ' for Component under the
‘Detailed Properties’ section

___c. Repeat the step ‘b’ for Invoke 2 and Invoke 3
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___d. Set the input variables

1) For Invoke 1, set the Operation to ‘newCustomerAccount

Events

a) Enter your own values or use the values below for each variable

} General Properties

= Detailed Properties

-3 330 ® [

E;F‘ Invaoke

']}F‘ Invoke

Configuration: IDeFauIt Module Test j
Module: I.ﬁ.ccuuntManagerESM j
Component: I.ﬁ.cmuntManagerESMExpDrt -s— j
Inkerface: I.ﬁ.ccuuntManagerInterFace j
Operation: InewCustDmer.ﬁ.chunt - j

Invoke export using binding

Initial request parameters

B
Mame | Type | walue |

=-Fs customer Custarmer ~ ;
el name stting + John
e customerID string W tulz34
= account Account +
“T1 accountID skring + acklz34
=-Hs customerInfo Farm hl

0 customerInfo  string + candidate

-1 date dateTine  \y/ 2D08-03-20T16:57:15,234 -0500

2) For the second invoke set the Operation to ‘terminate ' and set the accountID to match

that of the ‘newCustomerAccountinvoke

Events

B O0m|E
'f?F‘Inw:uke

E;F‘ Invoke

2008 April, 08
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} General Properties

= Detailed Properties

Confiquration: IDeFauIt Module Test j
Module: I.ﬁ.ccuuntManagerBSM j
Component: I.ﬁ.ccuuntManagerBSMExpnrt -~s— j
Interface: I.ﬁ.ccnuntManagerInterFace j
Qperation: Iterminate - j

Invake export using binding
Initial request parameters

Mame Type | Value |
E%g accounk Accounk W
Lol accountID =kring + acklz34
E%g reasonInfo Form W
..... T customerInfa  string i+ candidate
- date dateTime v 2008-03-20T17:01:39.512 -0500
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___e. Select the first invoke and press Continue (G) to invoke the operation

___f. Select ‘WebSphere Process Server V6.1 ' from the ‘Deployment Location ' dialog and click
‘Finish’

Note: Looking at the console messages you will see that the ReviewProcess business process was kicked off
and at the end it sends the activate event to the business state machine, which moves it to the Review state.

___g. Step through the state machine using the other two invokes
1) Select second invoke and press Continue (G) to invoke a ‘terminate ' operation
The next state will be the notActive state by way of the ‘terminate ' event or operation
2) For the final invoke, set the operation to ‘terminate ' and select Continue (G)

= Detailed Properties

Confiquration; IDeFauIt Module Test

Module: I.ﬁ.ccuuntManagerBSM

Corponent: I.ﬁ.ccauntManagerBSMExpDrt =

L L e e e

Interface: I.ﬁ.ccuuntManagerInterFace
QOperation: Iterminate ee—

Invoke export using binding
Initial requesk parameters

Mame | Tvpe | Yalue |
=-He account il
[ accountD ¥ actlzad
E%g reasonlnfo ¥
7 customerInfa i+ candidate
LT date v Z00E-03-20717:10:48.234 -0500

To leave the notActive state, you can ‘terminate ' or ‘reActivate ' using the remaining invoke or wait
for it to time out

3) When finished, close the test window without saving changes
5.  Remove all applications from the server

___a. Change to the servers view, right-click on ‘WebSphere Process Server v6.1 ' and select ‘Add
and Remove projects ' from the context menu

___b. Click the ‘<< Remove All ’ button to remove both projects from the server

___c. Click Finish
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Part 3: Add a condition

In this part of the exercise you will add a condition to the existing state machine. You might have noticed there
is already a condition on the transition from the Review state to the Active state. If you look at the code
associated with the condition, you will see that is really just a passthrough. You will add some logic to make it
perform checking to ensure that the new account is not activated prematurely.

1. Inthe project explorer, expand to ‘AccountManagerBSM - Business Logic -> State Machines ’
___a. Double-click on AccountManagerBSM to open the Business State Machine editor

2. Add Java logic to the ‘WaitFor’ condition

___a. Select the ‘WaitFor ’ condition on the activate transition between the ‘Review’ and the ‘Active ’
states

“m GccountManagerBan X

-
1

@ Begin

{a} newiZustomerdccount

| 37 Timeaut1
1 Start the review

Palette

! Timeout message

Renwigw
- .
e
423 resubmit = i) Enter notActive
-:'jj Exit nokactive
5% escalate
{5} Lerminate
Escllt 455 resubmit {7 TerminalTimeout
i) Enter Escalate & au:ti.\-'ate
7 Exit Escalate £5% berminate
{5} redckivate
Active @ End
i Enterfctive
) Exit Active

___b. While the ‘WaitFor ’ condition is selected, select the Properties tab

___c. Select the Details tab

<
Build Activities Problems | Servers | Console = =0
I . “
[Details -— < WaitFor
Ewent Maonitar | O ® o
Implementation: Wisual Invoke I k It
- Global Event Settings P s Sl e L tovert resu
ff Pass through for now -
=l
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___d. Ensure the implementation is set to ‘Java’

___e. Inthe text field, enter the following code:

/f Conditional logic to implement the "grace™ requirement.

Date signOffTime = (Date)activate_Input_customerInfo.get("date™);
Date currentDateTime = new java.util. Date();

System.out.println(” *** BSAM Condition - signoff time " + signOffTime.toString());

long t1;
long t2;
long delta;

System.out.println(” Signed Off: " + signOffTime.toString());
System.out.println{"Current: " + currentDateTime.toString());

tl = signOffTime.getTime();
t2 = currentDateTime.getTime();

System.out.println(tl);
System.out.println(td);
System.out.println(t2 - t1);

delta = (t2-t1) /60000; M minutes
System.out.println( "Delta( = 1 min 7) : " + delta );

if (delta>1)
i

System.out.println(”*** The "grace’ period is over.");
return true;

else
i
System.out.println™*** Waiting for period of time.™);

System.out.println{™*** Try again after 1 minute.™);
return false;

}

Note: For your convenience, this code can be found in
<LAB_FILES>\BusinessStateMachines\Snippets\Conditio = nLogic.txt

__f. Save (Ctrl +S) the business state machine

3. Add both applications to the server

___a. Right-click on the server and select ‘Add and Remove projects ' from the pop-up menu
___b. Click the ‘Add All >> " button to add both applications to the server
___c. Click Finish

4. Test the condition
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__a. Inthe project explorer, right mouse click the ‘AccountManagerBSM ' module and select ‘Test >
Test Module ’ from the pop-up menu

Note: If using a remote testing environment, select Project - Properties - Integration Test Client
Unselect the check box for ‘Always use the default target in the test client ' if selected and click OK. You'll
be prompted for your deploy location now when testing.

___b. Add two additional invokes by clicking the Invoke button twice

Events } General Properties
2 = | & L] + Detailed Properties
M-E2 % 0m|E
l'}P Invoke Configur akion; IDeFauIt Module Test j
i Tnvoke

Module: I.ﬁ.ccuuntManagerESM j

Note: Remember that the accountld, act1234, is used to correlate the entire system. Enter act1234 for
accountiD.

___C. Set the component to AccountManagerBSMExport for all the three invokes
___d. Setup the test conditions
1) For the first ‘invoke’, set the Operation to ‘newCustomerAccount '’
a) Enter your own values or use those from Part 2
2) For the second ‘invoke’, set the Operation to activate

a) The values for this invoke must match those from the step above
3) Select the first invoke (newCustomerAccount) and select Continue ('[3)

___e. This time you should see a message telling you to wait for one minute before invoking the review
operation again

*** \Waiting for period of time.
*** Try again after 1 minute.

___f. Wait one minute and then with the second “invoke”, invoke the activate operation manually using
the “Review signed off” timestamp reported in the log (select the second invoke, edit the
customerinfo date and select Continue ). The following should then be displayed in the console
along with some other diagnostic information:

*** The 'grace' period is over.
*** | eaving the Review state
*** Entering the Active state

___g. For final ‘invoke’, enter the values and change to the ‘terminate ' operation to move from the
active state to the non-Active

___h. If you wait five minutes in the nonActive state, the process will automatically terminate:
*** | eaving the notActive state
___i. Close the test window without saving changes when you are finished

5.  Remove all applications from the server
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Part 4. Completing the business state machine

To complete the Business State Machine you will need to:

Edit the ‘AccountManagerinterface.wsdl ' to uncomment the operations for ‘apply ' and ‘verify ’
transitions

0 Setup the correlations for the two new events

Insert two new states, ‘ApplicationPending 'and ‘VerificationPending’ , between the ‘Review’
and ‘Active ' states

0 Add ‘entry’ and ‘exit’ messages to both states
Update the ReviewProcess (BPEL)
o Toinvoke the ‘apply ' event instead of the ‘activate ' event
o Make adjustments to the comments in the Signed Off activity

o0 These changes are incorporated in the updated version of the
‘AccountManagementProcess ' module which is available for import

Create a VerificationProcess (BPEL)

o Create the ‘signOffTime ' and invoke the activate event to the business state machine
while in the ‘Verification ’ state

o This will require updates to the module assembly for both the
‘AccountManagementProcesses ' and the ‘AccountManagerBSM ' modules.

o The VerificationProcess (BPEL) is provided in the updated version of the
‘AccountManagementProcess ' module which is available for import

Add the transitions to the Escalate state from all the other states and put conditions on the
transitions

You can use the ‘customerinfo ’field in the ‘Form’ business object to pass information that you can use
for the condition test. This will be useful for the conditions on the escalate transitions and managing the

‘sighOffTime
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Below is a picture of what the basic layout will look like when this section is completed:

‘T‘ Beqin
5% newCustomerAccount Review
T start the review i Enter Rewiew
{3} — f Exit Feview
7 Check Source of Escalation {55 apply
5% psralate
T Set Vars £ resubmit ApplicationPending
X CheckSource i Enter ApplicationPending
Escalate ) Exit ApplicationPending
Py Enber Escalate g :ZET‘::
) Exit Escalate & acti'-.-'at.e. : ] 453 verify
& WaitFor [ Start the werification
Active
5 Enkerdctive
7 Exit Active &5 terminate YerificationPending

i Enter YerificationPending
) Exit erificationPending

rotAckive

& refictivate M Enker nokAckive

'_-’" Exit nokAckive
i) Terminal Timeaout

53 berminate {®) End
™ Terminate Meg

You will also add messages to the ‘entry ' and ‘exit’ actions of each new state and optionally the BPEL
processes that will be invoked as Actions on ‘apply ' and ‘verify ’ transitions.

1. Import the updated version of the AccountManagementProcess module
___a. From the file menu, select File = Import
___b. In the Import dialog, scroll down, expand Other and select Project Interchange

___c. Inthe Import Projects dialog, initialize the From archive file to
<LAB_FILES>\BusinessStateMachines\Snippet\AccountManagementProcesses.v2.pi.zip
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= Import Project Interchange Contents
Import Projects

Impark Projects Fram a zip file.

| = |
\_."-_.-r’

-
Fram zip File: IC:'l,LaI:uFiIesﬁ1'I,BusinessStateMau:hines'l,Snippets'l,.ﬁ.ccu:uuntManagementF‘rDcesses.vz.pi.zip j Browse... |
Project location rook: | CiLabfiless 1 BusinessStateMachinesiworkspace Browse, ., |
[=F AccountManagementProcesses
Deselect oll | Select Referenced
(7) < Back | Mext = | Firish | Cancel

___d. Select the module and click Finish . A conformation dialog pops up

#4= Confirm Overwrite

9P The following projects already exist in the workspace, and will be deleted
\*/ along with the underlyving conkents, Conkinue?

rﬁ.cmuntManauementPrDcesses

Ik | Cancel I

___e. Click OK to confirm overwrite

___f. There will be errors related to the ‘apply * and ‘verify * events. These will be cleared up in
subsequent steps

2. Open and remove the commenting in the AccountManagerinterface.wsdl file for the apply and verify
interface operations

Before modifying the state transition design diagram, the ‘AccountManagerinterface.wsdl ’ file will

need to be edited, that is the ‘apply ' and ‘verify ’ operations in the interface have been commented
out. They need to be uncommented.

Note: When developing a WSDL interface all the operations that are defined must be used. Unused
operations will be flagged as errors. You can import or develop your interface completely and comment out
the operations that you know you will not be using until a later date.

__a. Goto the Physical Resources view by selecting Window -> Show View -> Physical Resources
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YWindow Help

Plews Mindow . == .
Mew Edibor

Dpen Perspective L4
Show Yiew d i Build Activities

Customize Perspective. .. f= Business Integration

Save Perspective As. .. o= Cutling
Resel Perspective E Physical Resources

___b. In the physical resources explorer, expand ‘AccountManLib’ , right-click on
‘AccountManagerinterface.wsdl ' and select ‘Open With - XML Editor ' from the pop-up menu

=
Business Integration

el { | .
X L | == =

wsical Resources

fé‘ AccountManagementProcesses
TE-L‘_' AccountManagerBsM
Elﬂ AccounkManLib

[Eb beta

[Eb xsd-includes

---,1, .classpath

If] Account, xsd

@ AccountManagerInterface. wsdl
C] [ 3
e F3
& Open 'With 4 & (TiInterface Editor
Copy Chriec || Text Editar
Faste Zhrl Y S@WSOL Editar
3 Delete Delete B =ML Editor

___c. Inthe XML Editor, select the ‘source ' tab and scroll to the bottom of the page. Delete the <!--
--> comment lines for the apply and verify operation coding

..
B accountiianagerinterface.ws =3
<wsdl:operation name="terminate™: NS

<wadl:input message="ths:terminateRequestl=g™ name="terminateRecus
</wadl:operation>

<wsdl:operation name="apply™:>
<wadl:input message="tns:applyBequestMsg” name="applyRequest™/ >
</wadl:operations
<wazdl:operation namwme="verifyf>
<wadl:input message="tns:verifyRequestMsg™ name="wverifyRegquest'/ >
</wadl:operation:>

&2

</wsdl:portTypesr
</wsdl:definitions>

-
Desigrl [Su:uuru:e ] |
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___d. Save the changes (Ctrl+S)

___e. Assign the new correlations for use in the AccountManagerBSM module
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___f. Switch back to the Business Integration explorer. You can close the Physical Resources

explorer

__ 0. Inthe project explorer, expand AccountManagerBSM -> Business Logic -> State Machines

___h. Double-click AccountManagerBSM

to open the Business State Machine editor

___i. Using the palette on the right, select the ‘accountld ' property under the Correlation Properties

___j. Inthe Properties tab, click on the column next to ‘apply ' operation

Twpe: skring

Build Activities Froblems | Servers | Consaole
Description & accountld
Mame:™* accountld  ee—

Mamespace: htkp) e, w3, orgf 2001 [5MLSchema

Select or create an elerment From each operation that contains the correlation information described by this property:

@ AccountManagerInkerface add
{E} new_ustomerfccounk JaccountfaccountID Edit
%3 moralate laccauntfaccaunkID —
5% resubmit laccountfaccountID

5% activate JaccountfaccountID

5% reActivate JaccountfaccountID

5% rerminate laccountfaccountID

{2 apply -

5% verify

___k. Click the ‘Add’ button. The ‘XPath Expression Builder ' opens
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4= ¥Path Expression Builder

#Fath Expression Builder
Select the target from the Schema wiewer and drag and drop the nodes in the source viewer below, 5 S

Data Types Yiewer

= [E;I Data Types
---IEI cuskamerInfo @ Form
---IEI customer : Cuskomer
=-[€] account : Account

e IR -ccounkID ; shring JE -
#Fath Expression
faccountfaccountlld  eeE—— |

(7) Einish I Cancel |

___ L. Inthe ‘Data Types Viewer ' section, expand ‘account: Account 'and select accountID

___m. Click Finish
___n. Repeat the same for ‘verify ’ operation
___ 0. Save the changes (Ctrl+S)
Add the ApplicationPending state to the business machine

___a. Select the ‘Simple State’ icon from the palette to the left

1 —Palette —
[ B, &) )

|.—= States

(i Simple —E——
ﬁ Composite

@ Final

X Terminate

___b. Click anywhere on the Business State Machine Editor canvas to create the new state.
___c¢. Rename the state as ‘ApplicationPending ’

Add the VerificationPending state to the business machine
___a. Repeat step 3, naming the newly created state VerificationPending

Add the Entry and Exit actions to ApplicationPending

___a. Select the ApplicationPending state. A hover box will appear
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e f

ApplicationPending
-

___b. Select ‘Add an Entry ’

ApplicationPending
| Ame |
. L ]
___c¢. Rename the entry to Enter ApplicationPending

ApplicationPending
" Enter &pplicationPending

___d. Select the entry, Enter ApplicationPending and then select Properties view
___e. Inthe Properties view, click the Details tab and select Java implementation
__f. Select ‘Yes’ to the dialog box that appears

___g. Enter the following code:

System.out.printin( "=** Entering the ApplicationPending state ***"

__h. Select the ApplicationPending state and select Add an Exit from the hover box
<~

ApplicationPending

.-‘E:- Enter &pplicationPendi 'ild El0 (A

ApplicationPending

___i. Rename the exit to ‘Exit ApplicationPending

ApplicationPending

" Enker &pplicationPending
f Exit ApplicationPending

___j. Select the exit, Exit ApplicationPending and then select Properties view
___k. Click the Details tab and select Java implementation

___|. Select “Yes’ on the dialog box that appears

___m. Enter the following code:

System.out.printin( "% Exiting the ApplicationPending state ***"
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6. Add the entry and exit for VerificationPending

verificationPending

i Enter YerificationPending
] Exit VerificationPending

___a. Repeat step 5 for Verification Pending using the following entry/exit names and code snippets:

Entry name: Enter VerificationPending Exit name: Exit VerificationPending
System.out.printin( "=** Entering the VerificationPending state ***" );
System.out.printin( "* Exiting the VerificationPending state ***" );

7. Add the exit for the End final state

___a. Add an entry action name Terminate Msg

W End

0y Terminate Msg

___b. Click the Details tab and select Java implementation
___c. Enter the following code:

System.out.printin( "*** The Account Management Business State Machine has
terminated” );

8. Arrange the transitions so that you go from Review to ApplicationPending to VerificationPending
to Activate . ( See the diagram at the beginning of this section. )

___a. Select the transition from the Review state to the Active state and drag the source end and
attach it to the VerificationPending state

___b. Select the wire for the Timeoutl operation connecting the Review and notActive states; press
the delete key to remove it

___c. Select the wire for the reSubmit operation connecting the Review and Active states; press the
delete key to remove it

___d. Hover over the Review state until a yellow handle appears above the state. Then drag the
handle to ApplicationPending to wire the two states together and create a transition
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'T' Eedqin
{E} newCustomeraccount
T Skart the review
83 resubmit
5% moralate
Escalate
 Enter Escalate
) Exit Escalate
= 5% activate
7o WaitFor
Active
i Enberdctive
7 Exit Active 8 terminate
55 refckivate
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Review

E Enter Review

'_f: Exit Review

ApplicationPending

™ Enter ApplicationPending

f Exit ApplicationPending

YerificationPending

& Enter YerificationPending
) Exit WerificationPending

nobAckive

i Enter notackive
7, Exit notactive
i) Terminal Timeout

@ End

i) Terminate Msg

{E} terminate

2008 April, 08

___e. Create a transition from ApplicationPending

to VerificationPending

___f. The state machine diagram should look like:
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é Eeqin
{E} newCustamerAccount
[ Start the review REviaH
& - ™ Enker Review
resubmit ('_{T Exit Rewview
3% mscalate
i ApplicationPending
3 Enter &pplicationPendi
™y Enter Escalate - n. & DF ":é e er! =
o £t Escalate (';"j Exit ApplicationPending
= {E} ackivake /‘+
<7 WaitFor : &\
Ackive /
i Enberfctive VerificationPend
) Exit Active % terminate erificationPending

i) Enter YerificationPending
(I.T Exit YerificationPending

niokactive

i redctivate ™y Enker notActive

-:1“3l Exit nokactive
{27 TerminalTirmeouk

5% rerminate i® End
0 Terminate Msg

9. Create operations for the new transitions
___a. Select the transition connecting Review to ApplicationPending
___b. Select the Properties tab at the bottom of the screen followed by the Description tab

___c. Set the Type to Operation , the Interface to AccountManagerinterface , and the Operation to
apply

Build Activities Problems | Servers | Console
|

Transitionl1

o

VEE

[ Description e

Sandiog Type: O Automatic | O puration O Expiration O 1nternal

Ackion

Event Monitar Inkerface: AccountiManagerInterface  sE— [«
- Global Event Settings Cperation: apply  ae——— |E|

___d. Now, select the transition connecting ApplicationPending to VerificationPending

2008 April, 08 IBM WebSphere Process Server V6.1 — Lab exercise Page 27 of 41

WPIv61l_WPSWIDv61_BSMLab.doc



© Copyright IBM Corporation 2008. All rights reserved

___e. Select the Properties tab at the bottom of the screen followed by the Description tab

___f. Set the Type to Operation , the Interface to AccountManagerinterface

, and the Operation to

verify
Servers

Consaole

VEE

e

Build Activities Problems
|

Transition?

[ Descripkion  sS——

Condikion Type: ) Automatic
Ackion
Event: Maonitar Interface:

« Global Event Setkings Cperation:

AccountManagerInterface  =E—
WEFFY e —

O 1nternal

(<] [4]
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___g. The Business State Machine should now look like:

\_;K Begin
{5} newCustomerAccount
T Start the review
5% resubmit
5% escalate
Escalate
i) Enter Escalate
- Exit Escalate
= 5% actjvate
7 WaitFor
Ackive
i EnberActive
] Exit Active 455 terminate
{E} refctivate

™y Enker Review
(3‘? Exit Review

Review

v

{5+ apply

ApplicationPending

i Enter ApplicationPending
(3‘3 Exit ApplicationPending

H 5% verify

YerificationPending

™y Enter VerificationPending
(';"j Exit: WerificationPending

nokActive

™ Enber nokackive

(2’]‘ Exit nokActive ~
i) TerminalTirmeout

@ End

s Terminate Msg

{E} kerminate

10. Adjust the output in the Entry action of the Review state

___a. Highlight Enter Review action of Review state and click on Details in Properties view
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___b. Comment out these lines which are no longer appropriate here

Il System.out.printin("*** If the Review has not been completed in 5Smin");
Il System.out.printin("*** then move to the notActive state");
/I System.out.printin("*** .. you cannot activate until 1 min after it has been signed off");

11. Update the ReviewProcess (BPEL) to post the apply event

___a. These changes were incorporated when the new version of the AccountManagementProcesses
module was imported. Therefore, review these changes for your understanding

___b. Change the Activate activity at the end of the business process to invoke the apply operation
and change the name of the activity to Apply

12. Setup the action to invoke the VerificationProcess (BPEL) on the verify transition from
ApplicationPending to VerificationPending

NOTE: The VerificationProcess is new with version 2 of the AccountManagementProcesses and is available if
you did the import.

___a. Open AccountManagerBSM editor again if you have closed it
__b. Using the palette on the right, click (%*) to add the reference
1) Type VerificationProcess for reference name

2) Select VerificationProcesslinterface  for interface

';'.:. AccountManagerBSt

(1) Interfaces LU
F &ccountManagerInterface

= References - CEl

F ReviewProcess

| F YerificationProcessInterfacePartner  ae— |

W Yatiables LR
[ Correlation Properties LR
accountId

___c. Create the action on the transition

1) Highlight the transition from ApplicationPending to VerificationPending

2) In Properties view, select Action and click on Create button
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e s
Description Transition? -
Condition

Ackion  apE—
Event Monitbor

« Global Event Setkings

Build Activities Problems | SErvers | Console |

3) Highlight the new action and change the name to Start the verification

55 verify
T Start the verification

d. Add the reference that you just created for this action

e. Use this new reference and set variables in one to one mapping
1) Click on Details in Properties view of the action and select Invoke for Implementation
2) Select VerificationProcess for Reference and verify for Operation

3) Highlight customer in verify input of Variable field and highlight customer in Operation
input

4) Click on Set >

5) Repeat the step 3-4 for account and customerinfo

6) Save the changes (Ctrl+S)

- O E
Description Transition9
Condition —
. Mame:* Start the verification
[.ﬁ.ctu:un -
Event Maonitor Implementation: O visual Q Java @ Irvoke &
- iGlobal Event Settings | Reference: VerificationProcessInkterfacePartner |E| Cperation: verify EI
Parameker: ) Input € Cukput
Wariahles: Cperation inout;
...... r
st
<< Unset Al
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__f. Inspect the Module Assembly for the AccountManagerProcesses module. It was updated by the
module provider and was picked up when the module was imported

1) The VerificationProcess was added to the AccountManagerProcesses
was wired up using SCA bindings/

module assembly

o
coountManagementProcesses - Assembly Diagram X

= O

-

'E' 'E.#' ReviewProcessExport

—

Paletk

@ ,‘_:ZReviewPrncess 1.1

—

3] = AccountManager

(1) 2 VerificationProcess 1.1

@ 'E#"-.-'eriFiu:atiu:unF‘ru:u:essExp-:urt

13. Update the module assembly for the AccountManagerBSM module

___a. Add the import for the VerificationProcess to the AccountManagerBSM module assembly and
wire it to the AccountManagerBSM

1) Open the assembly diagram for the AccountManagerBSM module

2) Drag the VerificationProcessExport  from the AccountManagementProcesses module

and drop it onto the assembly diagram and select “import with SCA bindings " when
prompted

3) Rename to VerificationProcess
4) Delete the AccountManagerBSM from the diagram and save
5) Drag the AccountManagerBSM state machine back in and wire it to the export and imports

a) There should now be two references on the AccountManagrerBSM component

s =
g *AccountiManagerBsM - Assembly Diagram = 0

-

—_—

':i.:' Ec.{'l’.ﬁ.ccuuntManagerESMExpDrt

Palette

(1) |2 ReviewProcess

—_—

\;l_ algl
(1) = AccountManagerBsM
1.4

(@ [ verificationProcess

2008 April, 08 IBM WebSphere Process Server V6.1 — Lab exercise Page 31 of 41

WPIv61l_WPSWIDv61_BSMLab.doc



© Copyright IBM Corporation 2008. All rights reserved

6) Save and run Clean the project

Test the changes that were made.

_____14. Add both applications to the server
___a. Right-click on the server and select Add and remove projects
___b. Click the Add All >> button to remove both projects from the server
___C. Click Finish

___15. Startthe Component Tester on the AccountManagerBSM module.
___a. Right click on the AccountManagerBSM module
___b. Select Test - Test Module from the pop-up menu

16. Run the tests

Note: Remember that the accountld , act1234, is used to correlate the entire system.

___a. Add four additional invokes

1) Click on the Invoke button four times; there should be five invokes listed under Events

omponent: I.ﬁ.ccuuntManagerESM

section
Events » General Properties
; = = + Detailed Properties
&3 0m|HE £
gb Irrvoke Configuration: IDeFauIt Module Test j
B Irevoke

™ Tnvoke Module: I.ﬁ.ccnuntManagerESM j
P Invake j
[

Interface: I.ﬁ.ccnuntManagerInterFace
___b. Set the Component to AccountManagerBSMExport for all the invokes

___C. Begin testing the components.

1) For the first invoke, set the Operation to newCustomerAccount
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= Detailed Properties

Configquration: IDeFauIt Module Test

Module: I.ﬂ.ccnuntManagerESM

Component: I.ﬂ.ccnuntManagerBSMExpDrt w—

Lef Lef Lef e e

Interface: I.ﬁ.ccnuntManagerInterFace
Operation: InewCustDmer.ﬁ.chunt e

Invoke export using binding

Initial request parameters

|
Marne | Tvpe | Yalue

E%g cuskamer Zuskorner W

----- narme skrimg ffJ—nhn _‘\
e[ customerID shing L/ rus12354
E%g accounk Accaunt b

(7 accountID | skring L/ act1234
E%g cuskomerInfo Farrm -

----- I customerInfa  string il candidate

- 1 date dateTime 2005-03-21T03:32:05, 109 -I:I5I:II:IjJ

2) Select Continue (U) to begin the test. You should see this output displayed to the

console:

*** Entering the Review state

*rrekk Review Process *rx*

*** \We have a regular customer

*** Review signed off at: Fri Mar 21 03:30:27 CDT 2 008
*** | eaving the Review state

*** Entering the ApplicationPending

Notice that the state machine went right through the Review state this time and behaved
like an automatic transition. This because you send the apply event/operation form the
context of the ReviewProcess (BPEL).

___d. Use the second invoke to transition from the ApplicationPending state to the VerificationPending

2008 April, 08

1) Set the Operation for the second invoke to verify

2) Enter the accountld, act1234
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+ Detailed Properties

Confiquration: IDeFauIt Maodule Tesk

Maodule: I.ﬁ.ccnuntManagerBSM

Component: I.ﬁ.ccnuntManagerBSMExpDrt =

Lef Lef L e 10

Inkerface: IAchuntManagerInterFace
Cperation: Iverihf —

Irvoke export using binding

Iritial request parameters

= | Type | Yalue |
E-Hs customer Cuskomer
""" name skring John _\\
i - 1 customerID skring cus1234
E%g account Accounk

P b [ accountID string
=-Ha custamerInfo Farm

------ 7 customerInfo  string

el dake dateTime

acklz34

candidate
2008-03-21T03:37:28.750 -0, _,J

3) Select Continue (U) and the following should be displayed to the console:

*** Exiting the ApplicationPending state ***
*** Entering the VerificationPending state ***
*** \erification Business Process

*** \When complete, activate the new account

*** there is a rule, implemented as a condition on the transition

*** that requires a grace period before activating the new account
*** Request signed off and validated at: Fri Mar 21 03:40:40 CDT
2008

*** BSM Condition - signoff time Fri Mar 21 03:40:4 0 CDT 2008

Signed Off: Fri Mar 21 03:40:40 CDT 2008
Current:  Fri Mar 21 03:40:40 CDT 2008
1206088840000

1206088840359

359

Delta (> 1 min?): 0

*** \Waiting for period of time.

*** Try again after 1 minute.0000008e SystemOut

___e. Wait a least a minute and then use the third invoke to send the activate event/operation, using

2008 April, 08

the RequestSignedOff time from your console log.
1) Enter the accountID (act1234).
2) Change the customerinfo date to the RequestSignedOff time from your console log
3) Set the third invoke to activate

4) Select Continue (U) and the following should be displayed to the console:

*** The 'grace’ period is over.
*** Exiting the VerificationPending state ***
*** Entering the Active state
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___f. Use the fourth invoke to send the terminate event/operation. This will move the state machine to
the notActive state where it will wait for another terminate message or timeout after five minutes

2008 April, 08

1) For the final two invokes set the operations to terminate

- Detailed Properties

Configuration: IDeFault Maodule Test

Module:

Component:

Inketface:

Cperation:

I.ﬁ.ccnuntManagerBSM

I.ﬁ.ccuuntManagerBSMExpnrt gre—

I.ﬁ.ccuuntManagerInterFace

Iterminate -_—

Irvoke export using binding

Initial request parameters

Led L L e e

O
Mame | Type | Yalue
=-Hs account Accounk v
- I accountIm skring ' acklzs4
=-Hs reasonlnfo Form ¥
[ customerInfa  string v andidate
1 date dateTime +/ 2006-03-21T03:48:26.406 -0... )

2) Select the terminate operation and then Continue (12)

a) The log will display...
*** Entering the notActive state

*** | eaving the notActive state

3) Send the terminate event/operation again

a) The log will display...

*** The Account Management Business State Machine h

4) Close the test window without saving changes when finished
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Part 5: Add the escalate transitions (Optional)

To implement the escalations there must be distinguishing conditions on each of the reSubmit transitions so
the state machine will return to the state from which it came. This can be achieved with the aid of a global
variable which gets set during the transition to the escalate state, with a value that indicates the state the
Business State Machine was in when the escalation event was received.

Example : If the Business State machine is in the Review state when the escalate event is received, then the
value of the global variable is set to “Review”. The value of the global variable can then be checked in each of
the reSubmit transitions.
1. Create a global variable called SourceOfEscalation, of type string
___a. Add an action to the escalate transition that goes from Review to Escalate

1) Name the action, Set Vars

2) In the Set Vars action, set the SourceOfEscalation global variable to “Review”

Review” SourceQfEscalation

___b. Add a condition to the reSubmit transition that goes from Escalate to Review.
1) Call the condition, Check Source of Escalation

2) In this condition, check to see that the value in the SourceOfEscalation is equal to “Review”.

SourceDfEscalation =="Review”™ | = if true
rue return
otherwise
falze S return

___ €. Add escalate and reSubmit transitions between the Escalate and ApplicationPending states.

1) Follow the same procedure used for the Review state but this time the value assigned to
SourceOfEscalation global variable and compared in the condition is
“ApplicationPending”

2) Complete the escalate/reSubmit pairs for the remaining states, VerificationPending and
Active, using the appropriate values for SourceOfEscalation global variable and the
condition check

Note that this can quickly become difficult to manage. This is a place where the composite state would provide
benefit.
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2. Do another test cycle to verify the escalate transitions.
3.  Remove all applications from the server

___a. Change to the servers view, right-click on WebSphere Process Server v6.1 and select Add
and Remove projects...

___b. Click the << Remove All button to remove both projects from the server
___C. Click Finish
4. Stop the server

___a. Change to the servers view, right-click on WebSphere Process Server v6.1 and select Stop
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What you did in this exercise

Created and tested a Business State Machine that collaborates with a BPEL business process by way
of Actions on the transition

Added Conditions to the Business State Machine to apply business restrictions to the overall business
process flow

Used the WebSphere Test Environment to move through the states of the Business State Machine.

Programmatically sent events/operations to the Business State Machine from a long running BPEL
business process

Solution instructions

No solution is available at this time
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Task: Adding remote server to WebSphere Integration
Developer test environment

This task describes how to add a remote server to the WebSphere Integration Developer test environment.
This example uses a z/OS machine.

Create a new remote server.
1. Right click on the background of the Servers view
2. Select New - Server from the pop-up menu

i 1 = = \
Biuild .ﬁ.ctivities|Pererties|Pru:ul:ulemsm i 2 hn [ EL | =l =0

Server | Skatus | Skate |

E,"} Web3phere ESE Server va.1 g Stopped Republish

WebSphere Process Server w6, 1 . Started Republish

3. Specify host name to the remote server, <HOSTNAME>

4. Ensure that ‘WebSphere Process v6.1 Server ' is selected from the server type list

= New Server
Define a New Server

Choose the bype of server bo create

Server's host name: IrethE.austin.ibm.cDm -_— vI

Select the server bype:
Don't see wour server lisked? Click here

: WebSphere Portal v5.1 Test Environment ;I
0] ‘WebSphere Portal w&.0 Server
ebSphere Process va,1 Server Lt
-8 webSphere vS Server Attach

Wigtw By I'-.-'enu:lu:ur j
Description: Runs service projects on the WebSphere Process wa. 1 Server,

Server runtime: |WebSphere Process Server vo.1 - j Installed Runtimes. .. |

(7 = Back Pewxt = | Einish I Cancel |

5. Click Next
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6. Onthe WebSphere Server Settings page, select the radio button for RMI and change the ORB
bootstrap port to the correct setting (<BOOTSTRAP_PORT>).

4= New Server

Input settings for the nevs WebSphere server.

WebSphere Server Settings - g

—

WebSphere profile name: I j

—Server connection bype and admin pork

fre RMI (Designed ko improve communication with the server)

CRE bootstrap port: I 2809

~ S0aP (Designed to be more Firewall compatible)

SEAF conmectar park: | fatatall

I | Bun server, with resources within the workspace

['7 Security is enabled on this server]

Current ackive authenticakion settings:
F sl

Izer I: wpsE 1 admin

Password: I [TITTTITTITY!

SErver name: serverl

Setver bvpe

{+ BASE, Express or unmanaged Metwork Deployment server

Eirish Zancel

7. Click Finish

8. The new server should be seen in the Server view.

(" "y
Ewild .ﬁ.ctivities|Prnperties|F'ru:u|:|lem5 m ﬁ o =] | 3, = O

Server Skatus Skate
@ WebSphere ESE Serw iu; Stopped Fepublish

Weh3phere Process Server v, 1 [l Skarted Republish

WebSphere Process w61 Server @ remoke, austin.ibm,com E"p. Starked Fepublish ]

9. Start the remote server if it is not already started. WebSphere Integration Developer does not
support starting remote servers from the Server View.

10. From a command prompt, telnet to the remote system if needed:
‘telnet <HOSTNAME> <TELNET_PORT>"’
user ID: <USERID>

password: <PASSWORD>
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11. Navigate to the bin directory for the profile being used:
cd <WAS_HOME>/profiles/<PROFILE_NAME>/bin
12. Run the command file to start the server: ./startServer.sh <SERVER_NAME>

13. Wait for status message indicating server has started:

ADMU3200I: Server launched. Waiting for initializat ion status
ADMU3000I: Server cl1sr01 open for e-business; proc ess id is 0000012000000002
2008 April, 08 IBM WebSphere Process Server V6.1 — Lab exercise Page 41 of 41

WPIv61l_WPSWIDv61_BSMLab.doc



